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Dear Students,

We welcome you are  for joining & Certifying your education act from
NIOS. We are not only hopeful but also sure that you all  have started attaining
heights of success. You will be glade to know that NIOS is the biggest open
school education system in the world. It has around 5813 is study centers and
around 50,000 students get admission and pass with good marks.

NIOS is one part of three (CBSE, ICSE, NIOS) National Board in India.
India government has permitted to take exams into Senior & Sr. Secondary
level and gives Certificates. The syllabus of NIS is equivalent to any other Na-
tional and State level Educational Board.  A student passing through the NIOS
exam can take admission in any School / Colleges  / Universities all over India.

Successful student of NIOS are not only studying in top most Institution
of India like IIT, Delhi University, Jawaharlal Nehru University, Jamia
Hamdard University, AMU, AU, BHU but in colleges of foreign countries also.
They can do Engineering, Medical or chose any streams according to their
wish.

We play for your bright future and hope that studying in NIOS will make
your life successful and bright.

With best wishes from :

Co-ordinator
(National Institute of Open School)



44Why 12th only from NIOS Board?
It will not be exaggeration that in this competitive world NIOS is a boon

for the students.
In IIT-JEE, Medical and other competitive examination, now-a-days,

students are crushed in both schooling system and competitive examinations.
School demands 75% attendance compulsory and with other hard restric-
tions of schools so students do not get sufficient time for their competitive
examination. These students can not get admission in any standard institution
at KOTA, KANPUR  or big cities but tthey are forced at study in villages and
small cities. As a result, they are not able to get proper guidance and admis-
sion in I.I.T., Medical or any other advanced institution of Indian although
they are talented and genius live other selected students.

NIOS is an easy solution of this problem of students, Motto of NIOS ‘for
all and for everyone’ and NIOS follow ‘Principal of freedom of learning’ NIOS
provides freedom from class. It is class free educational system so students
get not only sufficient time but freedom to appear class anywhere in India.

NIOS is a ray ofhome for us parents they are overburdened wih wanted
end unnecessary high fee and extra-costly books of Public School. In NIOS,
there is nominal registration  fee and NIOS Board provides free books to all
the students. NIOS also provides free classes fro time to time as well as
remedical classes for all the students.

NIOS is the only board which conducts examination two times in an
academic calendar April-May and Oct-Nov. in this board these is system ‘Trans-
fer of credit marks.

NIOS  provides ‘On demand examination’ every month through out year.
Now-a-days, NIOS Board’s percentile in I.I.T., and other competitive

examination is better than CBSE Board marks. So its success ratio is increased
by leaps and bounds.

So, Let us join NIOS and Shape your golden future.
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Information Is  A Vital Resource In Development Activities Of Any Society. All Our Economic
And Social Progress Depends Significantly On The Transfer Of Commercial, Scientific And Technical
Information, People In Different Situations Require Information On A Subject In Different  Forms And
With Different Emphasis.

 GENERATION OF COMPUTERS
Now in order to have these three features, i.e., perform logical functions, perform repetitive  functions

and store data ans instruction (Memory) in a computer, certain components were made use of, which made
a lot of difference in the capacity of the computer. So depending on the rechnology in use, the computers
are said to belong to different generations.

 IST  GENERATIONS COMPUTERS (1945 - 1955) :-
The main components in use were the vaccum tubes (like thise in the old radios). This warmed up

after a minute or so and glowed red). The vaccume tubes were also called as valves. The first computer
used 17000 vaccum tubes, weighed 30 tons and occupied an area of a  big hall. Vaccum tubes or valves took
ages to warm up and consumed massive amounts of electricity. Some of the computers of this geeration are
ENIAC, UNIVAC-1.

 IIND GENERATION COMPUTERS (1955 - 1965):-

The real breakthrough in computers started with the discovery of the transistor (one can find 3
legged component inside all transistors/radios). Transistor is a tiny semi-conductor device; the size is about
1/50th of a Valve which can perform the same function as that of a large valve.Transistor replaced valves in
computers. The use of transistors has:

1. Reduced the size of computer.

2. Reduced manufacturing and running costs.

3. Improved reliability and processing power of the computer.

Computer which were built usinf transistors became the Second Generation Computers. Some of
the computers of this generation are: IBM 7000 SERIES. IBM 1620 1401. The Second Generation computers
were significantly faster than the first generation computer but things did not stop there.

 IIIRD GENERATION COMPUTERS (1965 - 1970):-

In the next step, functions of a numbr of transistors were put together on a single chip (wafer) of
silicon. These chips are called Integrated Circuit (IC) chips. A small chip, the size of a finger nail could
have the equivalend of 200 to 2000 transistors.

“Information is obtained through Processing of data”

INTRODUCTION TO
INFORMATION
TECHNOLOGY
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The chip is a small silicon wafer with very minute transistors, which can do logical comparisons and

calculations. Some chips have been developed for the purpose of data storage. These constitute the memory chip.
The use of chip technology reduced the size of computers. Computers, which were built using ICs, became the
Third Generation Computers. Some of the computers of this generation are: IBM 360. IBM 370.

 IVTH GENERATION COMPUTERS (1970 onwards):-

From 1970onwards, we are in the ara of Fourth Generation Computers, in which the electronic component
was further miniaturized through Large Scale Integration (LSI) of circuits on the silicon chip. Now the advancement
of chip technology has come to be known as Very Large Scale Intergration (VLSI), were  millions of transistors are
packed in a single chip. The VLSI chips are getting refined every  day. The size of the chip is shrinking and the
components which are packed in a chip are multiplying. As a result, the size of the computer is reducing. What used
to be a room-sized computer at one time is now available as Desktop computer or Lap-top computer with much
more computational power. Along with the reduction in size, there sihnificant reducton is prices, too.

 VTH GENERATION COMPUTERS:-

From 1982 onwards, research is on to develop a Fifth Generation computer that wil have the thinking
power just like that of the human brain. There compuyters which are based on Artificial Intelligence (AI)
are designed to be “Thinking computers” capable of storing large amount of data to be retrieved as and
when required solving a problem.

 TYPES OF COMPUTERS:-

There are different types of computer depending on the function they perform.

Analog Computers: A computer which measures continuously changing conditions, such as tenperature
and pressure, and converts them into quantities. These  computers are used in scientific and engineering
fields.

Digital Computers: A computer which measures digital data and perform arithmetic and logical operations
on such data. These are the most popularly used computers.

Hybrid Computers: Computer system the combine features of both analog and digital computers.
DATA Representation in Memory
 NIBBLE :- 4 Bits form on Nibble.
 Bits :- It stands for Binary Digit it is a single digit 0 or 1.

(0 mens off), (1 mens on)
 BYTE :- One Character Also A Group Of 8 Bit Is Called A Byte.
 KILOBITES :- A Group Of 1024 Bytes Is Called A Kilobytes.
 MEGABYTES :- A Group of 1024 Kilobytes is called a Megabytes.
 GIGABYTES :- A Group of 1024 Megabytes is called a Gigabytes. (1000 MB)
 TERABYTES :- A group of 1024 gigabytes is called a terabytes.

When Data Has Been Work Upon To Give It More, Meaning It Is Call As Information.

DATA :  A Collection Of Facts & Numbers.

FOLDER:  A Collection Of File.

A Create A Folder On The Desktop Right Click The Mouse Button Anywhere On The Space. A
Drop Down Menu Will Appear Choose The New Option, Then Folder.

ADAPTER : The Hardware That Fits Into A PC And Is The Main Outlet For The Connecting The Computer To
Other Systems.
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BROADBAND : A Communication Channel Having A Great Bandwidth And Therefore Capable Of
Multiple Parallel High Speed Transmissions.

BUFFER  : A Storage Space Where By Data Is Stored Before During Transmissions For Processing Speed.

BUS  : A Local Area Network That Uses Multiple Carrier Frequencies To Transmit Signals On A Single Cable.

PROTOCOL : A Set Of Rules, That Govern Data Transfer Among Devices On A Network. A Protocol
Identifies The Handshake Type Packet Size And Format Timing Error Recovery Scheme Work Size Or
Other Characteristics Of Each Transfer, Depending The System It Is Art Of.

REPCATER  : A Repeater Is A Network Device That Receives Signals, Sometime Regenerates Them And
Then Retransmits Them To All Ports Except The One They Are Received On.

SERVER : A Hardware Device And Software Module That Perform A Specific, Well Defied Service For
Many Users.

USER : The Person Allowed Working On The Network.

INTERNET : The Internet Is “A Network Of Network”, Internet Is Being Widely Used In Offices, Collage,
Bank And Other Services.

E-Mail, E-Card, Chatting, Downloading Online Education, Finding People Are Some Of The Uses Ad
Services Available On The Internet.

Internet Develop By 1969 In USA. A World Wide Collection Of Computer Work, Co-Operating With Each
Other To Exchange Data.

WWW : A World Wide Web Or Simply The Web Is A Massive Store House Of Information That
Resides On Computer, Call Web Servers.

Dial-Up : Dial-Up Is A Means Of Connecting To The Internet Or Any Other Computer Through A Modem.
This Means You Do Not Need Expensive And Complex Hardware Like  A High Speed Leased Phone Line
Terminal Server Unix Computer System To Have A Dial-Up.

HYPER TEXT TRANSFER PROTOCOL (HTTP): A Procedure Used To Transfer Information For A
www Page.

These Web Servers Are Located Are Over The World Each Web Server Hosts One Or More Web Sites
Counting Million Of Documents Called Web Page.

WEB PAGE : A Page Written In HTML That Available On The Internet Through The HTTP
Protocol.

WEB SITE : A Site Written Consisting Of Venous Web Page That A Be Accessed By
Anyone Connected To The Internet.

DOWNLOAD : TO Copy A File From A Remote Machine, For Example With Anonymous
FTP, On The Web When You Copy A Program For A Website To Your
Machine.

FIREWELL : A System To Prevent Unauthorized Access To Your Local Network From
The Out Side Firewalls Can Be Configured On Hardware Devices Like
Routers Or Can Be Software That Installed On A Computer.
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MODEM : (Modulator/De Modulator) – A Device That Is Required By A Computer For

Transferring Data Over Pain Old Telephone Lines. You Would Us Modems
To Connect To An ISP For Accessing He Internet.

ONLINE : You Are Online Means That You Are Connected To The Internal.

HTML : Hyper Text Markup Language (HTML)- Is A Computer Language Used To Create
Web Pages. Web Pages Are HTML Documents That Consist Of Text And Special
Instructions Called Tags. A Web Browser Interprets The Tags In An HTML
Document And Displays The Document As A Web Pages.

WEB-SERVER: Hold The Information which can be browsed on the internet.

INTER SERVICE PROVIDR (ISP) :- A Company Which Provides The Internet Service To The User.

WEB PAGE : A Page Which Displays The Content Of The Web Site An Also Consist Of Links
To Other Web Pages.

FTP : File Transfer Protocol (FTP) – Site Are Used For Storing Files Which Can  Be
Downloaded By The User.

E-MAIL : E-Mail Or Electronic Mail Is The Process Of Exchanging Message Electronically
Using Computer.

NETWORKING : A Network Is A Connection Of Two Or More Computer So That They Can Share
Resources.

TYPES OF NETWORKING:

1. Local Area Network (LAN): The Connection Of
Computer In A Single Room, With In  A Building Or
Building    On One  Side Is Normally Called Local Area
Network Or LAN.
2. Wide Area network:- Wide Area Network Are Large
Scale Data Network, Which Spare A Regional National Or
Global Area.
3. Metropolitan Area Network: Metro Area Network
Is Where We Join A Computer Of A Particular City Together.

NETWORKING
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INTRODUCTION:-   The word computer may be used for any device that is employed to
compute or to calculate. The electronic computer has increased the calculating power of human brain
billion time, it may be said that the invention of computer is the most important event of the modern age.
WHAT IS COMPUTER:- Computer is an electronic machine that helps us to store and process our Data
and/or instruction at high speed with accuracy. It can receive information, perform basic operations like
calculation and comparisons and produce results according to the given instructions in a desirable form.

A computer mainly works on the principle of input, process and output.

DEFINITION:-  A computer is an electronic  device, which inputs data/instruction, stores and processes, it and
produces output in the desired form.
CHARACTERISTIC OF COMPUTER:-  Computer executes one instruction at a time. It can add and
subtract numbers, compare characters to determine matching and copy numbers and characters.

The time required by the computer to execute such instruction if form few microseconds to a few nano-
seconds.

INDRODUCTION
OF COMPUTER
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ACCURACY:- In addition to the speed. Computer are very accurate. The input Data is valid and the program is
correct and reliable, then the computer will always produce an/ 00 accurate result.
PERMANENT STORAGE:- Both data and program can be stored in a computer if they are required for
future use.
SECRECY:-   In a computerized system more secrecy is observe as compared to manual system.
VERSATILE:-   Capable Of Doing Various Types Of Jobs At The Some Moment The Computer Has A
Number Of Characteristics Which Are Helpful In Out Daily Routine.
Speed, Accuracy, Versatile, Storage, Secrecy Are The Main Characteristics Of Computer.
APPLICATION OF COMPUTER:- We are on the threshold of a new information ere and future
generation may view our era as the time when people developed tools to amplify human intelligence.

Today computer are used in each and every field of life.
1. Personal 2. Management 3. Marketing 4. Money matter  5. Education 6. Scientific research 7.
Medicine 8. Transport 9. Robot 10. Law and Order 11. Bank 12. Animation and Graphics 13. Electronic
Publishing.

COMPONENTS OF COMPUTER:-
A Computer is also a system because it is a group of integrated parts, which are used to solve any

problem by executing a suitable program. The organization of computer system components has been
shown in fig.



7
INPUT/OUPUT UNIT:- The input are used input data into the computer
and the output unit takes output from a computer.  Example :-   Key
Board, Mouse, Joystick, Light pen, Bar Code Reader, MICR, OCR, OMR
and Scanner.

OUTPUT DEVICES :- Output Devices are the medium between you and
the computer. The Result given By the computer is called output.   Example:-
Monitor, Printer and Plotter, Speaker.
OUTPUT DEVICES:-   As the user communicates with the input Devices,
similarly computer converser with the user through output Devices.

 Visual Display Unit (VDU)  Printer

 Card and Tape Punch  Plotter

 Microphone  Speaker  Magnetic Disk

THERE ARE TWO TYPES DEVICES

 INPUT DEVICES &  OUTPUT DEVICES
The Devices through which the input provided to the system is called input devices like.

 Punched Card Reader  Paper Tape Reader
 Key Board  Optical Reader
 Optical Mark Reader  Scanner
 Bar Code Reader  Floppy Disk
 Tape Devices  Mouse
 Joy stick  Light pen

VDU (Visual Display Unit):- The most popular output device is the Visual Display Unit (VDU), also
sometime referred to as a Monitor. The most popular output device in the form that we can understand. The
viewing surface of a typical VDU is equal to that of a 12 or 14 inch TV. The VDU output  is referred to as
a soft-copy output. Most of the monitor can display 25 lines of text with 80 characters in each line. Most of
te VDUs seen today use a  cathode ray  tube (CRT) whereas, there are some monitors which use liquid
crystal display (LCD).

VDUs can display in single colour (monochrome) or in many colour(colour). The mode of display
can be either text or graphic. This visual display screen s divided into rows and column of tiny dots, squares
or cells, each of which is a picture element or pixel. A pixel is the smallest element to create pictures and
text in different formats (styles). A collection of pixel will be used to represent a character or a picture.

A screen capable of displaying large number of pixels is capable of a high resolution or graphic
resolution screen. The high resolution screen is capable of displaying sharp images.

Text mode - display of text materials Graphics mode - display of pictures
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CPU:- Central Processing Unit is the heart of any computer system. It consists of
                         primary memory unit, arithmetic logic unit and control unit.

“CPU is called the heart of Computer”
CONTROL UNIT(CU):- Control Unit Controls all the hardware operations. Input output units, storage
and have the processor itself.
ARITHMETIC LOGIC UNIT (ALU):- The arithmetic and logic unit in computer are capable of
performing addition, Subtraction, division and multiplication as well as some logical operation.

MEMORY:- The memory unit is an essential component in any digital computer since it is needed for
storing the programs that are executed by the CPU.

The memory unit that communicates directly with the CPU is called the main memory and
devices that provide backup storage and called auxiliary memory device only programs and data
currently used by the processer reside the main memory. Memory can be divided in two Primary
Memory and Secondary Memory.

INTRODUCTION

OF HARDWARE
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THE PRIMARY MEMORY ALSO HAS TWO PARTS:

RAM (Random Access Memory)—Dynamic Ram, Static Ram
ROM (Read Only Memory)

“Primary Memory is the temporary memory where as Secondary Memory is the Permanent
Memory”.
The Secondary memory is the memory is the memory, which is found outside computer system. A Large
quantity of Data can be stored permanently on it.
Secondary devices like floppy disk, hard Disk, CD.

The word computer may be used for any device is employed to compute or to calculate. Input
data in side the computer or the CPU and take the output/Results from the CPU.

KEY BOARD :- The keyboard is the most common and simple
input Device is allows you to communicate with the computer. It
consists of four main areas the 1.  function key, 2. Type writer key,
3. Numeric Key, 4. Special Purpose key.

MOUSE:-  The Mouse is an input device that is addition to the keyboard.It is a hand held device that controls a Pointer on the screen.

PRINTER : Printer are the primary output devices used to prepare permanent documents. Along with the
computer screen, a printer serves as a medium for the computer to tell us what we have send in as an
input and what it has done in response to the some.

There are two types Printer.

 Impact   Non Impact

 Impact -  Dot Matrix ,  Daisy Wheel

 Non impact - Inkjet Printer ,  Laser Printer

USB PEN DRIVE :- USB pen Drive is a small key ring sized Device that can
be use to easily transfer files between USB computable systems.

Note:- Mouse is pointing Devices.
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SCANNER:-  A Device called a scanner lets an editor Digitize pictures that is transform  them into digital signals
that can be processed by a computer.

HARD DISK :– A Disk are made up of a magnetic material are sealed inside
a case. It is used to stores lots of programs and Data. Which is called Drive C:
and is placed inside the computer case (CPU)

FLOPPY DISK:- It is a circular thin plastic jacket with magnetic material. A hard plastic as outer caver
protects this plastic disk. These disk are very useful in transferring data
from one computer to another.

CD ROM :–It stands for compact Disk Read only Memory.

A CD Rom is a storage Device that can store much more information than a
floppy disk. It is very useful for distributing large data/information storage
capacity.

PLOTTER :– Plotter is a specialized output Device Designed to produce
high quality graphics in a variety of colours.

NOTES:- Using scannr, you can scan your pictures and Drawings.
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WINDOW’S OPERATING SYSTEM
An Operating System Is A Set Of Programs Called System Software Which Provides An Interface Between
Computer Hardware, User And Application Programs.

The Operating System Is The Software Leaded Into Memory When A Computer Starts.

This Concept Is Called Booting.

There Are Many Important Reasons For Studying The Operating System. Some Of Them Are:-

 User Interacts With The Computer Through An Operating System In Order To Accomplish His
Task As It Is His Primary Interface With A Computer.
 It Helps The Users To Understand The Inner Functions Of A Computer Very Closely.
 Many Concepts And Techniques Found In An Operating System Have General Applicability In

Other Application.
Types Of Operations System

An Operating System Is The Interface Between The User And The Hard Ware Of The Computer. An
Operating System May Be Single User Or Multi User.

Five Types Of Operations Perform By The Operating System.

 Single User
 Multi Programming
 Multi Processing
 Time Sharing

 Real Time
The Most Popular Operating Systems.

 CP/M  UNIX 3. XENIX  VMS
 SOLARIS  OS/2 7. MS DOS  WINDOW’S NT
 VISTA,  XP

Developed By Microsoft Corporation.
What is Window’s

Window’s Is An Operating System Program That Controls All The Parts Of Your Computer. It User
A Graphical User Interface (GUI). This Kind Of Interface Display Graphical Object Called Icons.

A GUI Is An Interface Which Allows The User To Interact With Computer Through The Use Of
Pictures And Graphic Instead Of Typing Text.

WINDOW’S
ACCESSORIES



1212

File Edit View Insert      Tools        Desktop    Window Help My MenuIn the view menu , there are six options available………
1.   Toolbar 2. Colour Box 3.  Status Bar 4. Zoom 5. View Bitmap   6. Text Tool Bar

PART OF WINDOWS

DESK TOP :- This is the main screen of Ms. Window’s. It is used by some operating system.

STATUS BAR :- It is a strip or bar along the bottom of the screen as information is display by most application
here.

We see a series of menu commands such as :

Menu:- It is a list of options displayed on a computer from 
which you can choose. Menus may be in word, pictures or 
icon.
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ICONS :-  The icon are the small Pictures on your Desktop. There icon are used to run specific program and are
known as the short cuts to those programs. Normally, you will find number of icon on a desktop.

 My Computer (provides complete hardware and software) on your computer.
 My documents.
 Internet explorer (Microsoft Internet) brewing program used to surf Internet.

Recycle Bin (all deleted items are stored in this folder. You can recall or delete permanent delete (items).

MOUSE OPERATION:- Generally the Basic technique of using amouse depend on the programs for which it is used. A Mouse canbe used to open any program file, folder.
LEFT BUTTON :- Selection of program or icon or application.
RIGHT BUTTON:- Invoking shortcut.

FOLDER ICON:- A directory or a sub-directory is called as a
folder in MS-Windows 95 and later versions. Generally, it  contains
its own set of icons. The contents of the folder will be displayed,
when double clicked on the folder icon.
PROGRAM ICONS :- The program icon represents an application or executable program. When double
clicked on the icon, the program that it represents will be executed.

DOCUMENTS ICONS:- The files created  by the user (letters, pictures, worksheets etc.,) are treated as

documents in MS-Windows and later versions. Document icon represents a document that can be generally

printed. The icon will have the icon like a folder page on the upper right corner of it. Double clicking on the

document will automatically open the program that is required and open the document.
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WINDOWS OPERATION:-  The small Buttons in the upper right corner as shown in Microsoftword window are very handy to operate.
 Use the (Minimize) :- Button to reduce the window to a
button on the taskbar.
 Use the (Maximize) :- Button to enlarge the window so
that it covers the entire desktop.
 Use the (Restore) :- Button on Return the window to its
pre-maximized sixe.
 Use the (Close)   Button to close the window.

 Shut down:- Start Button and short down from the start menu.
 “It’s now safe of turn off your computer”.

At last switch off your power switch.

WINDOW’S EXPLORER:-Windows explorer is another application included in windows. Using
windows explorer you can view and organize the file on your Disk”.

 Click on start, program, windows Explorer.
WALLPAPER:- Windows comes with several file
that can be used the background for your Desktop.
These include Black thatch, Blue Rivets, Bubbles,
circles, Chess etc.

 To change your wallpaper – Right click on the
Desk top

  Select your wallpaper.

PRESS OK
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WINDOWS ACCESSORIES
  Windows XP Comes With A Number Of Applications That Can Make You Productive

Immediately With Out Having To Install Expensive Software On Your System.
 Notepad  #  WordPad # Ms Paint # Character Map # Clipboard # Clock # Calculator
MS WORD:-  A Word Processor Is A Computer Program That Enables You To Create, Edit, Print And
Save Documents For Future Revision And Retrieval.

A Word Processor Provides The Ability To Create And Edit Letters, Memos And Other Text Material.

There Are Many Word Processing Software Packages Available – Word Star, Word Perfect, And Ms Word.

MICROSOFT
WORD

  START   ALL PROGRAM  MS OFFICE   MICROSOFT  WORD
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MS Word 2007, A Popular Word Processing Soft Ware, Is Part Of A Suite Of Application Programs

Developed By Microsoft Office 2007.

 Automatically Number Line Or Paragraphs.           Create Table To Store Data

 Create Line Drawings And Insert Graphics.
 Put Lists In Order.  Create Indexes And Table Of Contents Automatically.
 Edit A Document While Printing Another Document.
 Merge Mailing Lists With A Documents.

1. Title Bar:- At The Top Of The Window Is
The Title Bar, Which Shows The Of The Name
Of The Program, “Microsoft Word” Followed
By The Documents Name.

2. Menu Bar:-  Below The Title Bar Is The Menu
Bar. The Menu Bar Contains All The Options
As You Need When Working With Word, If
You Click On One Of The Menu Items, A
“Dropdown Menu” Appears.

3. Tool Bar:- The Menu Bar Are The Toolbar,
Which Are Rows Of Button With Graphic
Symbols Or Icons. The Button On The Toolbar
Represent The Command Or The Procedure.
By Default The Standard Toolbar And Formatting Toolbar Will Be Display.

4. Ruler Bar:- The Ruler Bar Is Displayed By Default And Appears Underneath To Toolbar. It Is Used
To Set Tabs, Indents And Margins For A Documents.

5. Status Bar:- The  Status Bar Is Seen At The Bottom Of The Word Windows. This Bar Will Always
Show Your “Current Position” As For As The Text Goes On The Active Document.
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File menu (New, Open,   Save):-

6. CREATING A NEW DOCUMENT
Now You Have Completed Your Four Of The Word Interface, It Is The Time To Get To Work. The
First Thing Is To Create A New Document. As You Have Already Seen, Word Open With A Blank
Document, Already Display

To Create A New Document  (Ctrl + N)  :-

Click On The New Document Button On The Standard Toolbar.

 Choose File New From The Menu Bar.

    Press (Ctrl + N) On The Key.

7. Save A Document  :- Save A Document Its Information Is Store Only In Your Computer RAM. Your
Work On The Document Could

Be Lost In The Event Of Power Outage
Or System Crash.

  Choose On The Save Button
 Of Standard Toolbar.
  Choose File  Save From
The Menu Bar.

This Dialog Box Is Used To File Name To Save The File. The File Name Address  In The File Name Box
And Click Save Button.
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8. CLOSING A WORD DOCUMENT :-

Under The File Menu Is The Close Option.

To Close All Open Document With Out Exit The Program, Hold Down Shift And Click Close All
On The File Menu.

9. Exit Word:- Even If A Word Application Is Minimize It Is Still Running. To Quit A Word Application, You
Must Exit The Application.

From The File Menu, Choose Exit.
Or

Click The Close Button In The Title Bar.

10.  Open A Document  :- You Are Now Ready To Open The File Name Address, Doc., As In All
Window’s Application, The Open Command Of File Menu Is Used To Open File.

 Click The File Button 1
On The Standard Toolbar.


 Choose File Save
From The Menu Bar.
Press (Ctrl + O) On TheKey Board.
Choose The File  From TheList Or Write The Name OfThe File In File Name BoxAnd Click The Open Button.
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11. Page Setup:- This Option

Given You Information Read The

Page, Information Means The

Details Regarding The Margins,

The Position Of The Page On

Papers Be Modified Or Created.

 Click The Open File

Button. On The Standard

Toolbar.

 Choose File   Page

Setup. From The Menu Bar.

12. Print :- This Option Is Used

To Take A Printout Of Your Document

Created.

 Click The Open File Button 

On The Standard Toolbar.

 Choose File   Print From The

Menu Bar.

 Press (Ctrl + P) On The

Keyboard.
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EDIT MENU   (Cut, Copy, Paste):-

Now You Know That How To Select Text You Should Become

Familiar With A Very Common Procedure Used In All Types Of

Documents Moving And Copy Text. Using Word, You Can Move

Text Around At Will Until You Are Satisfied With Its Content

And Organization.

@  Moving (Cutting) Text :-

1. Highlight The Text To Be Moved And Select Edit Menu ®

Cut From The Menu Bar. OR

2. Click The (Cut ) Button On The Standard Toolbar,  OR

Press (CTRL + X) At Once, This Will Move The Text To A

Clipboard.

13. Copy Text :-

1. Highlight The Text That Will Be

Copies And Select Edit  Copy

From The Menu Bar. OR

2. Click The Copy Button  On The

Standard Toolbar.

3. Press (Ctrl + C) To Copy The Text To The Key Board.

14. Paste Text  :-

1. To Paste Cut Or Copied Text Move The Cursor To

The Location You Want To Move The Text And Select Edit 
Paste From The Menu Bar. OR

2. Click The Paste  Button On The Standard Toolbar.

OR

3. Press (CTRL+ V) .

15. Undo () and Redo ():- With All This Cut, Paste Dragging

And Dropping, It’s Common To Make A Mistake. It’s The Time

To Discuss Words Undo And Redo Feature. Undo Reverses

The Effects Of An Action And Returns Your Documents To

The Way. It Was Before You Perform The Action.

1. Click Undo () Button On The Standard Toolbar.
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The Undo Button Includes A Drop – Down List Button. Click This Button Displays A List To Your Most

Recent Actions.

The Redo Button Is Available So You Can Restore The Action You Just Undid.

2. Click Redo () Button On The Standard Toolbar. The Redo Screen Should Be Similar To

Shown In To Reverse This Action Again.

16. FIND :- TO Find Out Methodologies For Finding Text.

Press (Ctrl + F) To Find The Text To The Key Board.

17. REPLACE:- With The Replace Command, You Can Find And Replace Text Or Formatting You
Can Automatically Replace All Of The Found Text.

Press (Ctrl + H) To Replace The Text To The Key Board.

18. GOTO:-  Moves The Insertion Point To
A Special Location In The Document, For
Example You Can Move To A Page
Number.
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The Find And Replace Commands Search The Entire Documents, Beginning At The Insertion Point.

1. Choose Edit  Find. OR Press Ctrl + F.
2. Press The Button  From Toolbar.
3. In The Find Tab Of The Find And Replace Dialog Box That Appears, Enter The

Text That You Want To Find.
4. Click The Find Next Button.
5. The More Button In The Find And Replace Dialog Box.

19. Replacing Text:- To replace existing text with New text :-
1. GOTO Into The Edit Menu And Select Replace. That The Find And Replace Dialog Box Will

Appear With “Replace With” Box.
2. In “Find What” Box, Type The Text Which You Want To Search.
3. In The “Replace With” Box. Type The New Text.
4. To Replace Only One Occurrence Of The Word. Click The Replace All Occurrences Of The

Text, Click On The “Replace All” Button.

20. Highlight Colour:- Use This Option To Change The Colour Behind A Text Selection. The Colour Shown
On The Button Is The Last Colour Used. To Select A Different Colour Click The Arrow Head Next To
The Image On The Button.

21. Text Colour:- This Option Changes The Colour Of The Text. The Colour Shown On The Button In The
Last Colour Chosen. To The Button Image To Select Another Colour.
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22. Text Formatting (Fonts):-

This Is A Useful Feature Of Ms Word. Using Formatting Is To Change Font, Size, Style Of Text.

Using Formatting Technique, You Can Make Your Text Bold, Italic And Underline. You Can Also Change

The Background Colour And Font Colour Of Text.

  The Choice Of Font   Font Size

  Font Style   Underline

  Font Effects  Font Colour

 Spacing  Text Animation

You Can Control Any Type Of Font Formatting Through The Format  Font Dialog Box.

 Style Menu :-  Styles Are Explain In Detail Later In The Box.

 Font Face:- Click The Arrow

Head To The Right Of The

Font Name Box To View The

List Of Font Available.

 Font Size:- Click On The

White Part Of The Font Size

Box To Enter A Value For The

Font Size. A Font Size Of 10

Or 12 Is Best For Paragraphs

Of Text.

 Font Style: - Use These

Buttons To Bold, Italic And

Underline.

 Alignment :- Text Can Be

Align To The Left, Center, Or

Right Side Of The Page.

 Bullets & Numbering: - List

Are Explain In Detail Later In

This Tutorial.

 Increase/Decrease Indent: -

Change The Indent Of

Paragraph In Relation To The

Side Of The Page.

 Outside Border:- Add A

Border Around A Text

Selection.
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23. Paragraph Formatting:-

So For, You Have Worked Only With Font Formatting A Formatting Which Effects Only Characters.

Now, You Will Learn About The Formatting That Word Can Apply To Paragraphs. A Paragraph Is One Of The

Basic Unit Of A Document. Every

Time You Press The Enter Key

While Typing, You Are Creating A

New Paragraph.

In Word, Paragraph Formatting

Includes The Following, Include

The Following.

 Paragraph Alignment.
 Outline
 Indentation
 Spacing Between Line.
 Spacing Before And After
Paragraph.
 Line And Page Break.
 Tab

 Left Indent :-  Adjust The Left
Edge Of Every Line In
Paragraph.

 Right Indent:- Adjust The Right
Edge Of Every Line In A
Paragraph.

 Hanging Indent:- Leave The
Left Line Alone But Move Every
Line Beneath It.

 First Line Indent :- Move Only
The First Line Of A Paragraph.

24. Drop Cap:- A Drop Cap Is A Large
Letter That Begin A Paragraph And
Drops Through Several Line Text.
Place The Cursor With The Paragraph
Whose First Letter Will Be Dropped.
 Select Format  Drop Cap From
The Menu Bar.
 You To Select The Position Of The Drop
Cap, The Font , The Number Of Lines
To Drop, And The Distance From The
Body Text.
 Click OK
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25. Spelling Checking :-

If Word Has Found A Word That Does  Not Appear In Its Dictionary Your Choices Include.
 Ignore All:- Tells Word To Ignore All Occurrences Of The Word In The Document. Choosing This

Option Removes The Wary
Underline From The Words
Throughout The Document.

 Language:- Enables You To
Change The Language Of The
Spelling Dictionary.

 Spelling:- Opens The Spelling
Dialog Box, Which Offers More
Options.

o If Word Shows A Green Wavy
Under Line Indicating A Possible
Grammar Error, Right Click To
See The Grammar Shortcut
Menu.
 Instruct Word To Ignore The
Sentence.

 Open The Grammar Checker To See
More Options.

 Choose About This Sentence
To See More Information About The
Potential Error Word.

VIEW MENU:-

Word 2007 Has Four Different View, That You Can Work In –
 Normal View  Web Layout View  Print Layout View

NORMAL VIEW:-

To Access The Normal View, Select View From The Menu Bar And Goto To Normal.

The “Normal View” Button   To Left The Horizontal Scroll Bar.

WEB LAYOUTVIEW:-

Web Layout View Is Used For Creating And Editing Web Pages. Document In Web Layout View Behave
Like Browsers Where The Text Wraps To Fit The Windows.
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PRINT LAYOUT VIEW:-

Print Layout View Displays The Entire Page Exactly As It Will Print, Including Columns, Headers Footer
And Page Numbers. By Default, Two Rulers Will Be Display In Print Layout View.

To Access Print Layout View Select View From The Menu Bar And Goto Print Layout. The “Print
Layout” Button  To The Left Of The Horizontal Scroll Bars.

OUTLINE VIEW:-

To Access Outline View, Select View From The Menu Bar And Go Into Outline. Click The “Outline”
Button  To The Left Of The Horizontal Scroll Bars.

PRINTING DOCUMENT:-

Suppose You Don’t Want

To Print  Your Entire

Document You Want To

Use A Different Printer,

Or You Want To Print

Copies Of The

Document. Choose File

  Print  OR Press

(CTRL + P).

 Print  The Page Your

Insertion Point Is In By

Choosing Current Page

From The Page Range

Area Of The Dialog Box.

 Select Specific Text And

Print  That Text  By

Clicking The Selection

Button.

 Select Specific Pages To Print By Entering The Page Number In The Text Box Next To The Pages Button.

BREAK COMMAND:- Insert

A Page Break, Column Break, Or

Section Break At The Insertion Point.

 Choose Insert  Break.

  Select Page Break From The

Options Button List.
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BORDER & SHADING:-

Borders And Shading Are Two Separate Features That Can Work Text.

 Borders Can Be Placed Around Any Text With In A Document.

 Shading Can Be Applied To The Background Of Text.

TEXT BORDER:-
You To Pace Line Above, Below To Left Or To The Right Of Selected Characters Or Paragraphs.

PAGE BORDERS:-
Enables You To Place Simple Or Graphic Borders At The Top, Bottom, Left Or Right Sides Of A Document
Page.

SHADING:-
You To Add Colour Or Shades Of Grey To Selected Characters Or Paragraphs.
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HEADER AND FOOTER:-

Header And Footer Exist On Every Page In A Word Document. Until You Put Something In Them.

“Text That Appears Repeated At The Top Of Each Page Is Referred To As A “Header”.

Text That Appears Repeated At The Bottom Of Each Page Is Referred To As A “Footer”

 CHOOSE VIEW  Header & Footer Word Switches To Print Layout View Displays The Header And

Footer Toolbar.

 Enter Anything You Want In The Header. Click The Switch Between Header And Footer Button  On

The Toolbar.

DELETE A HEADER & FOOTER:-

 Go Into The View Menu And

Select Header And Footer.

 Highlight The Text In The Appropriate

Header Or Footer Text Box And Press

The Delete Key On Your Key Board.

PAGE NUMBER :-  You Have

Learn How To Insert Page
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Number In A Header & Footer By Using A Bottom That Add A Field.

 Click Any Where In The Document.

 Choose Insert  Page Numbers.

 From The Position List, Select The Location For Your Page Number.

From The Alignment List, Select The Paragraph Alignment For The Page Number In The Header Or Footer.

CREATINGATABLE:-

“A  Table Is A Series Of Row And Columns In Which We Organize Data With In A Document.

Tables Can Be Either In The Form Of Database Or Simple List Of Related Records.”
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A Data Base Table Can Be Used As A Data Source File To Merge Records From A Table With A

World Main Documents.

INSERTATABLE :-

 Position The Insertion Point Where You Want

The Table To Appears.

 Choose Table  Insert  Table Display The

Insert Table Dialog Box.

 Enter The Number Of Columns And Row For

The Table In The Numbers Of Columns And

Number Of Rows Boxes.

 Select An Auto Fit Behavior Option.

TO INSERTA COLUMN:-

 Select The Row Above Or Below Where You

Want To Insert A Row.

 Choose  An Option From The Insert Submenu

On The Table Menu.

 Row Above & Below. Insert A Row Below The

Selection.

WORD ART:-

Word Art Is An Office Application That Allows You Manipulate True Type Fonts.

 Click The Insert Word Art Icon The Drawing Toolbar Or  Click Insert  Picture  Word Art.

 Choose The Basic Style Of Word Act.
 In The Edit Word Art Dialog Box As Shown. Type The  Text. You Want To Use A Word Art, Then Select

The Font Size And Treatment And Click OK.
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 COLUMNS:-  When Working With

Columns A Continuous Selection.

“You Can Have Up To 12 Columns

In Portrait Orientation And 18

Columns In Landscape

Orientation”.

INSERT COLUMNS:-

 To Insert columns into a Documents.

 Select the text that you with to convert

to columns.

 GOTO into the Format Menu and

select columns.

In the “columns” dialog Box, select the

Number of columns to be used.

USING MAIL MERGE:-

Mail Merge is the process of creating mailings or other documents that combines Unique information with standard

text to create a set Unique document type, one for every recipient.

Mail Merge uses two special Kinds of documents.

 Main Document Contains The information that remains

the some for each letter. This is a text based file which is saved like

a general. DOC file.

 Data Source Document Contains the information that

changes for each letter of merged document. In a form letter, the

data source would contain the name and addresses of the people to

receive the letter.



Data Source Document Contains the information that

changes for each letter of merged document. In a form

letter, the data source would contain the name and

addresses of the people to receive the letter.
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 BULLETS LISTS ON DESIGN TEMPLATES :- Bulleted lists allow you to clearly display the

main points of your presentation on slides. The text boxes on design templates alreadt include

bulleted lists. Click the placeholder on the

slide to begin adding text and press the EN-

TER key to return to the next line and add  a

ew bulleted item. To go to the next line with-

out adding another bullet, hold down the

SHIFT key while pressing ENTER.

1. In slide view, create a text box by se-

lecting Insert  Text Box from the menu

bar.

2. “Draw” the text box on the slide by

holding down the left mouse button hile you

move the mouse until the box is the size you

want it.

3. Choose the Bullets or Numbering

from the Home  Paragraph menu bar.

4. Change the size of the bullet by chang-

ing the percentae in relation to the text.

5. Choose a colour for the bullet from the Colour menu Click More Colours for a larger selection.

6. Select one of the bullet

types shown and click

OK. Or click the Picture

button to view the Pic-

ture Bullet window. Se-

lect one of the bullets and

click OK. Or lick the

character button to select

any character from the

fonts on the computer.

Select a symbol font such

as Wingdings or

Webdings from the Bul-

lets from drop-own

menu for the best selec-

tion of icons. Click on

the characters in the grid

to see them larger. Click OK. when you have chosen the bullet you want to use.
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BULLETED LIST & NEW SLIDES FROM  AN OUTLINE:- In Normal or Outline view, text can

easily be entered in the outline window and new slides are automatically added. Follow the steps

below to become familiar with adding slide content in Outline view:

 Next to the Slide 1 icons, type the title of the slide. The text you type beside the slide icons with be

the large-type titles on each slide.

 Press ENTER key to type the next line. This will automatically create a new slide. To create a

bulleted list for the first slide, press the TAB key or ALT+SHIFT+RIGHT Arrow keys to demote

the selection toa bulleted list item.

 Continue entering text for the bulleted list, pressing ENTER key at the end of each line to create a

new bullet.

 Create a multilevel list by executing the above action again to create a bulleted sublist. Press

ALT+SHIFT+Left Arrow keys to return to the original list.
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5. Continue creating new slides and bulleted lists by using the above actions until the presentation  is

completed. Use the formatting instructions below to format the lists.

If there is more than one bulleted list on the slide, the lists will be designated by numbers enclosed

in black boxes. The example below shows the slide created from the outline on the left. The bulleted list on

the left slide of the slide is labeled list “1” on the outline and the list on the right is labeled list “2”. When

typing the outline, begin typing in the new list by pressing CTRL+ENTER keys.

Numbered List :  Follow these step to create a numbered list :

 Create  a text box.

 With the text box selected, choose Home Paragraph  Numbering from the menu bar.

 Click the Numbered tab at the top of the Bullets and Numbering window.

 Change the size of the numbers by changing the persentage in relation to the text.

 Choose a colour for the numbers from the Colour menu. Click More Colours for a larger selection.

 Change the Start at value if the numbers should not begin with 1.

 Select one of the sevel list types shown and click OK.
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AUTOSHAPES AND SMART ART:-
The Autoshape feature of Word allows you to draw a number of geometrical shapes, arrow, flow

chart elements, starts. and more on the document.

The steps to activate and use Autoshapes are

 Click on Insert Tab.

 From Illustrations Group, Click on Shapes

Now Select the which you want to insert.

Different categories of Autoshapes available in Word 2007. We will briefly discuses some of the here.

1. Lines - After clicking the Lines button on the Autoshapes toolbar draw a straight line, arrow, or

double-ended arrow from the first row of options by clicking the respective button. Click in the

worksheet where you would like the line to begin and click again where it should end. To draw a

curved line or freeform shape, select curved lines from the menu.Click in the document where the

line should appear, and click the mouse every time a curve should begin. End creating the graphic

by clicking on the starting end or pressing the ESC key. To scribble, click the last button in the

second row, click the mouse in the document and hold down the left button while you draw the

design. Let go to the mouse button to stop drawing.
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2. Connectors - These lines can be used to connect flow chart elements.

3. Basic Shapes - Click the Basic Shapes button on the Autoshapes toolbar to select from many two

and three dimensional shapes, icons, braces, and brackets. Use the drag - and - drop method to

draw the shape in the document. When the shape has been made, it can be resized using the open

box handles and other adjustments specific to each shape can be modified using the yellow dia-

mond handles.

4. Block Arrows - Select Block Arrows to choose from many types of two  and three-dimensional

arrows. Drag-and-drop the arrow in the socument and the use the open box and yellow diamond

handles to adjust the arrowheads.

5. Flow Charts - Choose from the flow chart menu to add flow chart elements to the document and

use the lines menu to draw connections between the elements. We have drawn a flowchart using

lines, flow chart elements and connectors.

6. Stars and Banners - Click the button to select stars bursts, banners, and scrolls.

7. Call Outs - Select from the speech and thought bubbles, and line call outs. Enter the call out text

in the text box that is made.
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CLOSE A MICROSOFT WORD:-
To close the current document file, select Offices button  Close Command on the menu bar. If

the file contains any unsaved changes, you will be prompted to save the file before closing.

EXIT MICROSOFT WORD PROGRAM:-

When finished your work in Microsoft Word and closed all the files, you can quite the Microsoft
Word program by selecting Office button  Exit Word command on the menu bar.
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KEYBOARD SHORTCUTS KEYS :- Keyboard shortcuts can save time and the
effort of switching from the keyboard to the mouse to execute simple commands. Print
this list of Word keybaord shortcuts and keep it by your computer for a quick reference.

ACTION KEY STROKE
Ope a file CTRL + O
New file CTRL + N
Close a file CTRL + W
Save  As F12
Save CTRL +  S or  SHIFT +F12
Print Preview CTRL + F12
Print CTRL +  P
Show/Hide paragraph symbols CTRL +  *
Spelling and Grammar F7
Help F1
Find CTRL + F
Replace CTRL + H
Go To CTRL + G
Select All - entire document CTRL + A
Select from cursor to beginning of line CTRL + HOME
Select from cursor to end of line CTRL + END
Go to beginning of line HOME
Go to end of line END
Go to beginning of document CTRL + HOME
Go to end of document CTRL + END
Cut CTRL + X
Copy CTRL + C
Paste CTRL + V
Undo CTRL + Z
Redo CTRL + Y
Format painter CTRL + SHIFT + C
Left alignment CTRL + L
Center alignment CTRL + E
Right alignment CTRL + R
Justified CTRL + J
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Delete previous word CTRL + Backspace
Apply bulleted list CTRL + SHIFT+L
Indent CTRL + M
Page break CTRL + ENTER
Font face CTRL + SHIFT + F
Font size CTRL + SHIFT + P
Bold CTRL + B
Italic CTRL + I
Underline CTRL + U
Double underline CTRL + SHIFT + D
Word underline CTRL + SHIF +  W
All caps CTRL + SHIFT + A
Change case SHIFT + F3
Subscript CTRL +  =
Superscript CTRL + SHIFT + =
Make web hyperlink CTRL + K
Go to next cell TAB
Go to pevious cell SHIFT + TAB
Go to beginning of column ALT + Pageup
Highlight to beginning of column ALT + SHIFT + Pageup
Go to end of column ALT + Pagedown
Highlight to end of column ALT + SHIFT + Pagedown
Go to beginning of row ALT + Home
Highlight to beginning of row ALT + SHIFT + Home
Go to end of row ALT + End
Highlight end of row ALT + SHIFT + End
Column break ALT + SHIFT + Enter
Copyright ALT + CTRL + C
Date field ALT + SHIFT + D
Go to footnotes ALT + CTRL+ F
Show/Hide CTRL + SHIFT + 8
Thesaurus SHIFT + F7

Note: A plus sign indicates that the keys need to be pressed at the
same time.
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HOW TO WORK WITH EXCEL:
If a novice user wants to start Excel, it is highly recommended to complete the task in very systematic

manner. If you’re really interested to be a good user don’t forhet the following sequence of excel learning, after
completing these steps you’ll be much confident about the conceptual part of Excel. The steps are given as:

Start the Excel Session
Working with single/multiple sheets
Calculation
Saving
Editing and Formatting or Worksheet
Graphical representation
Advanced features
Web based applications of Excel.

Data interface with other family member of OFFICE

Excel basic file format is the workbook which can hold multiple worksheet. A worksheet is a collection of information
laid out in columns and Row.

 A Value is a piece of information that does not change. Values can be texts, numbers, dates or
times. A cell containing a value usually display the value.

 A formula is a collection of values, cell references, operators and predefined function that, when
evaluated by Excel, produces a result.

  “The Worksheet Is Grid Of Columns And Rows. The Letter And Number Of The Columns And
Rows Are Displayed In Gray Buttons Across The Top And Left Side Of The Worksheet.”

 The start menu, choose Programs and then select Microsoft Excel from the Microsoft offices list
shown.

EXCEL : AN INTRODUCTION
Microsoft Excel is the most popular spreadsheet program. Microsoft Excel’s interface is intuitive and

easy to use, although all its numerous features and functions can be intimidating. However, you can easily master
the basics of Excel, and once you have done that, it’s relaively straight forward to learn the more complex
aspects of the program. To simply classify Excel as a spreadsheet program is in-appropriate,  because its data
analysis and presentation capabilities go beyond those of a standard spreadsheet - and its an application
development environment. This means that by using only Excel, you can design a complete, customized application
that does just what you need due to its following features.

MS EXCEL
EXCEL - AN INTRODUCTION
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 Multiple Undo up to the last 16 actions.
 Easier entry of range dialog boxes that eccept range references.
 references in dialog boxes collapses the dialog  box to a smaller size.
 Yes to All option when you quit with multiple files open which you can choose to save all
the files before exiting.
 Closing multiple files.
 IntelliMouse pointing device, the new mouse uses wheel button to scroll or zoom.
 Row and column headings as you move the highlight for the active cell.
 Better drag-and-drop editing, drag the border of a range of cells to move the rage to another
workbook or worksheet window.
 Full Screen command is to view more worksheet.
 Save a list of workbooks as in previous versions.
 The Save Workspace command on the File menu save a list of the open workbooks, thier sizes,
and their positions so that the screen will look the same the next time you open the workspace file.

 START   ALL PROGRAM  MS OFFICE   MS  EXCEL
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HOW TO WORK WITH EXCEL :
If a novice user want to start Excel, it is highly recommended to complete the  task in very systematic

manner. If you’re really interested to be a good user don’t forget the following sequence of excel learning, after

completing these steps you’kk be much confident about the conceptual part of Excel. The steps are given as:

 Start the Excel Session.

 Working with single/multiple sheets.

 Calculation.

 Saving.

 Editing and Formatting of Worksheet

 Graphical representation.

 Advanced features

 Web based applications of Excel.

 Data Interface with other family member of OFFICE.

The brief description of each step is given for your cenceptual clarification.
a) Start the session: After starting the session of session of Excel it appears with a set of

worksheet of  3 family members, several row/column and cells as discussed earlier where it
is ready to solve all the data manupulation part related to excel. At this stage you can start
the Data entry, Editing, Deleting, Adding different font, colout, scaling size, relate data with
appropriate formulae, etc. Some of the task will be done automatically and rest has to be done
as per your requirement.

b) Working with Single/Multiple sheet:  All the said data will be entered into cells which is a
part  of the worksheet where you’re free to work with the single sheet and multiple sheet. If
a financial or annual presentation requires the summary data on the main page and related data
on a different part of the same worksheet or any other worksheet, it can be arranged as per the
user’s choice. If a user wants to complete the required task under the same worksheet or
multiple sheets, the main data will be calculated and linked to the main page of presentation
where you have the options to complete the task by sinple linking of data and hyper linking
to jump into the document after user’s request.  Multiple sheets can be used for keeping all
the data in separate segment which  can be linked later.

c) Calculation:- The calculation will be done after the final compilation of entire statement
with the help of formulae and Functions (which has several categories) based on the data
segments, a lot many inbuilt functions and formulae have been given.

d) Saving:- The saving of entered data is much important for you for further accessing because
after entering the data and making calculation, it is utmost important to save the working
status. It has several options which will be discussed later.

e) Editing and Formatting or Worksheet:- The editing and formatting of worksheet is very
much necessary for the users for manipulating and making corrections in case of errors.
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Editing means spell correction, data re-entry, etc., Formatting means changing the layour of
any data in the Worksheet.

f) Graphical representation:- The entered data will be convered into graphical format to make
data presentation much meaningful. If you’re much aware of different tyoe of graphs, it will be
much easier for you to complete the task with good concept.

g) Advanced features:- The complete advanced features can be used as Pivot table and other
kind of special features which are able to present complete professional report.

h) Data Interface with other family members of OFFICe:- The entered data can be re-
manipulated into several formats with other pachges of same platform and different platforms.
For instance the data entered into excel can be converted/linked/hyper linked with Word,
Power point and Access.

i) Web based applications of Excel:- The web player or new web onlooked can take the major
potential of the web based applications like sending data for the same on web online/off ine
The job can be  done very  easily for you after a average look of menus  available in Excel. In
next step we’re going to discuss about the menus available in Excel, more or less it has the
same menu options like WORD but the different options available are discussed here.

EXCEL COMPONENTS:-

TITLE BAR:- The Title bar appears at the top of the Microsoft Excel window’s and displays the name of the file
you are currently working on.

Minimize/Maximum/Close Buttons:-

The minimize ,  Maximize , and Close , Button are located in the upper right portion of the
Excel windows.

 MENU BAR :- The Menu Bar, Located Below The Title Bar, Contains All Available Menu Items. Single
Click On A Menu Item, To Display A Drop Down List Of Options Related To The Selected Menu.

 TOOLBAR:- Tool bar, located below the menu line, contain various shortcut Button. To display the
name of the Button hover your mouse directly over the button. A name will be display in a yellow box right
below the button.

 THE STANDARD TOOLBAR:- The toolbar is located just below the menu bar.

 FORMATINGTOOLBAR:- The contents of high light cell can be formatted in many ways. Font and
cell attributes can be added from shortcut buttons on the formatting bar.

VIEWTOOLBAR FORMATTINGTOOLBAR FROM THE MENU BAR.
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 WORKBOOK:- Each new spreadsheet that is

created in Excel is called a workbook. A workbook
is made up of column, labeled by letter, and Row,
labeled by numbers.

CELL:- A cell is located at the intersection of a
row and column.  The Cell Reference Box
 FORMULA:-  The formula Bar located
below the formatting toolbar and to the right of
the cell reference box, displays text as it is keyed
in cells.

 SCROLLARROW:- The arrows to the
left worksheet names may be used to scroll to other worksheets not currently displayed on the screen.

 TASK BAR:- The taskbar is the horizontal bar located at the bottom of spreadsheet in Excel a new
icon is display on the taskbar. Each icon displays the application’s icon and the name of the Document. Fox
example if five
spreadsheet are
open in Microsoft
Excel.

 S C R O L L
BAR:- Scroll
Bars are located t o
the right of the
screen and used t o
scroll the screen u p
or down. Scroll
bars are also
located at the
bottom of the
screen to scroll the
screen right or left.

 Notes :   “By default, Excel contain 16 Worksheet.”
STATUS BAR:- Below the horizontal scroll  bar is the status Bar. It display the current working status in

cells.

Notes :   “By default, Excel contain 16 Worksheet.”
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 FORMAT CELL:-   For  a completes, list of formatting options, right click on the highlighted cells and

choose format cells from the shortcut menu or select format  Cells from the menu bar.

 NUMBER TAB:- The Data type can be selected from the option on this tab. Select General if the cell

contains text and numbers.

 ALIGNMENTS:- These options allow you to change the position and alignment of the date with the cell.

 FOR TAB:- All of the font attributes and display in this tab including font face, size, style and effects.

 BORDER AND PATTERN TABS:- These tabs allow you to add borders, shading and background

colours to a cell.
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 OPENINGA NEWWORKBOOK:-

 On The Standard toolbar, click.
The New button or Press CTRL+N or from the file menu, choose New.

 If You Choose New from the file menu, click workbook on the General Tab in New Dialog Box.
 A Workbook Consists of one or more worksheet which usually conform to a standard design  of rows

and columns of data. Most worksheets have headings at the top of columns and at the left end of rows
and calculation at the bottom of columns and/ or at the right end of rows.

 A Cell Can Hold Up To 65,000 Characters.

 There are 256 columns in each sheet identified by letter.
“when you open a new workbook. It use contains multiple work sheet each work sheet has 256 columns
and contents 16777216 cell.” Row 65536.
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 SAVING WORKSHEETS :-  It Is Important To frequently save new workbooks and changes you

make. Microsoft office applications provide two save commands.  Save and Save As. “Save As”
allows you to name the file and place it in a specified folder.

 Choose file  save or choose file  As or Press CTRL+S.
 Press Alt+F2, Alt+shift+F2

Or
Shift+F12

 Click The Save Button  On The Standard Toolbar

 Go Into The File menu and select save.
 Or, single click on the “save” button on the standard toolbar.
 Or, Press CTRL+S on the Keyboard.
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 OPENING :- After

you’ve create. Save and
closed the file, you will
probably need to reopen
it at some time in the
future to edit it, to print
an extra copy or to
simply check it for
important information,
Excel Provides as
variety of ways to open
existing workbook files.
 Choose File  

Open
 Click On The

File And Press
Open Button.

 CTRL+O  Or,
Click Standard Tool.

 DELETING SHEETS.

 Click On The Sheet Tab For The Sheet You Want To Delete To Select It.
 Right Click The Sheet Tab And Choose Delete Or Choose Edit   Delete Sheet.
 A Warning Appears.
 Click Or To Confirm That You Want To Delete The Sheet.
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 GROUPING  AND UNGROUPING SHEET:- Sheet can be grouped to facilitate creating or formatting

two or more identical sheets. For example. You can create one sheet and copy it to two other sheets or you
can group three blank sheet and enter the sales report contents once – no subsequent copy is required.

 Click One Of The Tabs That You Want In The Group And Press The Ctrl Key.

 With The Ctrl Key Held Down, Click The Remaining Tabs In The Intended Group Of Sheets.
 All The Grouped Sheets Tab Will Turn White And The Indicator Will Appear In The Title Bar After The

Workbook Name.

 CUT AND PASTE :-
 Select The Cell You Want To Move.
 Choose Edit   Cut, Or
 Press CTRL+ X, Or
 Click The Cut Button On The Standard Toolbar.

 An Animated
Marquee Appears Around
The Selection:-
 Select the cell
choose Edit   Paste
 CTRL+V, Or Enter  OK.
 Click the Paste button on the standard Toolbar.
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 COPY AND PASTE:- When using the

combination copy and Paste commands of Excel,
you accomplish the same results as copying data
by the drag and drop method, but it has one
advantage you can cy one cell and Paste it into
many cells.
 Select Cell
 Select Copy From The Edit Menu
Or
Choose Copy Button In Standard Toolbar.
 Select The Paste Command From The

Edit Manu. Or Choose Paste Button In
Standard Toolbar.

a) Enter numbers, text, a date, or a time
1. Click the cell whee you want to enter data.
2. Type the date and press ENTER or TAB.

Use a slash or a hypen to seprate the parts of a date; for example, type 9/5/2002 or
5-Sep-2002.

To enter a time based on the 12-hour clock, type a space and then a or p after the
time; for example, 9:00p. Otherwise, Microsoft Excel enters the time as AM.

b) Entering formulae
1. Click the cell in which you want to enter the formula.
2. Type    “=”    (an equal sign). If you click EditFormula or Paste Function, Microsoft

Excel insert an equal sign for you.
3. Enter the formula.
4. Press ENTER.

c) Enter the same data into several cells at once
1. Select the cells where you want to enter data. The cells can be adjacent or nonadjacent.
2. Type the data and press CTRL + ENTER

d) Enter or edit the same data on multiple worksheets
When you select a group of sheets, changes you make to a selection on the active sheet are

reflected in the corresponding cells on all other selected sheets. Data on the other sheets may be
replaced.

1. Select the worksheet where you want to enter data.
2. Select the cell or cell range where you want to enter data.
3. Type or edi the data in the first selected cell.
4. Press ENTER or TAB.
5. To cancel a selection of multiple sheets, click any unselected sheet.

If no unselected sheet in visible, right-click the tab of a selected sheet, and then click Ungroup
Sheets on the shortcut menu.
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WORKING WITH CHARTS:- Prologue to charts : It is said that one picture is worth a thousand
words. In any data presentation system charts plays a role for anlytical representation of data. If you
are much aware about the statistics and believe in analysis and management part you can take
chance with excel charting system that shows the final touch of any data analysis system. To complete the
task first data preparation part of any business or corporate model is very necessary. If you’re new to
Excel go in more concise way to understand the main stuff like Creating a chart, How worksheet data is
represented in a chart, Embedded charts and chart sheets. After completion of this session you’ll  be able
to complete the following topics:

o Why charts

o Formation of Chart

o Basic Concept

o Create a chart in one step

o Components of a chart

o Create a chart from nonadjacent selections

o Data Organized in a Chart

o Saving and  Retrieval of Charts

o Rypes of Charts

 WHY CHARTS? Chart are visually appealling and make it easy for users to see comparisons; patterns, and

trends in data. For instance, rather than having to analyze several columns of worksheet numbers, you can

see at a glance whether sales are falling or rising over quarterly periods, or how all the actual sale compare

to the projected sales. You can create a chart on its own shet or as an embedded object on a worksheet.

You can also publish a chart on a Web page. To create a chart, you must first enter the data for the chart

on the worksheet. Then select that data and use the Chart Wizard to step through the process of choosing

the chart type and the various chart options.

 BASIC CONCEPT:- The charts can be created based on some data models. If you are not aware about the

details just think that a complete data model can present the complete charts which can be embedded or

non-embedded. If it is embedded the mapping  of chart will be automatically changed after entering the

data. In Excel you have the options that you can create the charts with the help of wizards or by following
the steps given in excel. The following facts are much important for any chart representing system.

WORKING
WITH CHARTS
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Working data and chart: You can also create a chart in one step without using the
Chart Wizard. When create this way, the chart uses a default chart type and formatting,
that you can change later. Worksheet data is represented in a chart: A chart is linked to the
worksheet data and it’s  created and updated automatically when you change the worksheet
data. The appearance of chart is completely based on following tables.
 COMPONENTS OF A CHART:-

Axis value: Microsoft Excel creates the axis values from the worksheet data, Note that the axis values
in the example above range from 0 to 9000, which encompasses the range of values on the worksheet.
Unless you specify differently, Excel uses the format of the upper-left cell in the value rage as the number
format for the axis.

Category names: Excel uses column or ro heading in the worksheet data for category axis names. In the
example above the worksheet row heading 1st Quarter, 2nd Quarter, and so on appear as category axis
names. You can change whether Excel uses column or row headlings for category axis names or create
different names.

Chart data series names : Excel also uses column or row headlings in the workdheet data for series names.
Series name appear in the chart legend. In the example above, the row headlings Projected and Actual
appear as series names. You can  change whether Excel uses column or row headings for series names or
create different names.
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 DATA  MARKERS:- Data markers with the same pattern represent one data series. Each data marker

represents number from the workdheet. In the example above, the rightmost data marker represents the
Actual 4th Quarter value of
6000.

1. The chart area of the chart.
2. The plot area of the chart.
3. The date points of the date
series that are plotted in the
chart.
4. The horizontal (category) and vertical (value) axis along which the data is plotted in the chart.
5. The legend of the chart.
6. A chart and axis title that you can use in the chart.
7. A data label that you can use to identity the details of a data point in a data series.

Chart sheet: A chart sheet is a separate sheet within your workbook that has its own sheet name. Use a
chart sheet when you want to view or edit large or complex charts separately from the worksheet data or
when you want to preserve screen space as you work on the worksheet.

TYPE OF CHART: The main types of charts available in Excel are fourteen (14), which has been divided
into several sub categories called sub-segments. Each type of charts is fully compatible to present any
business data. The Main kind of charts available in Excel is :

1.Column 2. Bar 3. Line 4. Pie 5. XY (Scatter)6. Area 7.
Doughtnut 8. Radar  9. Surface 10. Bubble 11. (Hi- stock Cylinder 12. Cone 13.
Pyramid 14. Low close)

Column: A column chart shows data changes over
a period of time or illustrate comparisons among
items. Categories are organized horizontally,
values vertically, to emphasize variation over time.
Stacked column charts show the relationship of
individual items to the whole data. The 3-D
perspective column chart compares data points
along two axes. In this 3-D chart, you can
compare four quarters of sales performance in
Europewith the performance of two other
divisions.
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Clustered Column and Clustered Column 3-D

Stacked Column and Stacked Column in 3-D

100% Stacked Column and 100% Stacked Column in 3-D

Cylinder, cone and pyramid
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Line Chart : A Line chart shows comparison along two data series on from of line and placed horizontally. One

should use line chart when category labels are text representing evenly spaced values such as months, quarters
or fiscal years.

Bar:  A Bar chart illustrates comparisons among individual items. Categories are organized vertically, values
horizontally, to focus on comparing values and do place less emphasis on time. Stacked bar charts show the
relationship of individual items to the whole.

XY (Scatter) : An XY (Scatter) chart either shows the relationships among the numeric values in several data
series or plots two groups of numbers as
one deries of xy coordinates. This chart

shows uneven intervals - or clusters - of

data and is commonly used for  scientific

data. When you arrange your data, place

(x)  value in one row or column, and then

enter corresponding (y) values in the

adjacent rows or columns. The cone,

cylinder, and pyramid data markers can

lend a dramatic effect to 3-D column and
bar charts.
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 Stock : A stock chart that measures volume has two value exes: One for the columns that measure volume, and

the other for the stock
prices. You can include
volume in a high-low-close
or open-high-low-close
chart.

 Doughtnut : Like a pie chart, a doughnut chart shows the relationship of parts to a whole, but it can contain
more than one data series.
Each ring of the doughnut
chart represent a data series.
The high-low-close chart is
often used to ilustrate stock
prices. This chart can also be
used for scientific data, for
example,  to indicate
temperature changes. You
must organize you data in the
correct order to create this
and othr stock charts.

 Surface : A surface chart is useful when you
want to find optimum combinaitons between two
sets of data. As in a topographic map, colours and
patterns indicate areas that are in the same range of
values. This chart shows the various combinations
of temperature and time that result in the same
measure of tensile strength. You have option to
complete the selection of any kind of charts before
and after formation of data model. In case of the
complete formationof data, it can be enhanced by

adding the element of charts for further presentation.
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 Area Charts : Data that is arranged in columns or rows on a worksheet can be plotted in an area chart. Area

charts emphasize the magnitude of change over time, and can be used to draw attention to the total value
across a trend. For
example, data that
represents profit over
time can be plotted in an
area chart to emphasize
the total profit.

By displaying the sum of the
plotted values, an area chart also shows in relationship of parts to a whole.

 Pie Charts : Data that is arranged in one column on row only on a worksheet can be plotted in a pie charts
show the size of items in one data series (data series: Related data points that are plotted in a chart. Each data
series in a chart has a
unique color or pattern
and is represented in the
chart legend. You can
plot one or more data
series in a chart. Pie
charts have only one
data series.),
proportional to the sum
of the items. the data
points (data points :
Individual values
plotted in a chart and
represented by bars,
columns, lines, pie or
doughnut slices, dots,
and various other
shapes called data
markers. Data markers of the same colour constitute a data series.) in a pie chart are displated as a percentage
of the whole pie
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 Bubble Charts : Data that is arranged in columns on a worksheet so that (x) values are listed in the first column

and corresponding (y) values and bubble size values are listed in adjacent columns, can be plotted in a bubble
chart.

For example, you would organize your data s shown in the following example :

 Radar Charts : Data that is arranged in columns or rows on a worksheet can be plotted n a radar chart. Radar
charts compare the aggregate values of several data series.

Other types of charts that you can create in Excel

If you do not see the chart type that you want to ceate on the list of available chart types, there may be another way
to create it in Excel.
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SALES REPORT AND CHART :-
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SALES CHART COLOUR SCHEMES :-

  Categories are
organized horizontally, values
vertically, to emphasize
variation over time. Stacked
column charts show the
relationship of individual items
to the whole data. The 3-D
perspective column chart
compares data points along two
axes. In this 3-D chart, you can
compare four quarters of sales.
Sales is a data field that
summarized the entries from the
Sales field, or column, in the
source data. In the indented-
format report example, this field
is named Sales instead of Sum
of Sales
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SHOWING THIS DIFFERENT CHART :-

1.

2.
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3.

4.
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In this chapter we’ll discuss about the database features of excel which makes data access
much reliable with the help of different office tools. The detail of each section is discussed for your
complete reference. After completion of this session you’ll be able to  master the following details:
 Pivot Table : Concepts

 Create a Pivot Chart report

 Pivot Table report : Elements

 Deletion of a Pivot Table report

 Creation of a Pivot Table report

 Query

 Using an existing Pivot Table or Pivot Chart report

 CREATING A PIVOT TABLE REPORT :-
To create a Pivot Table report, use the Pivot Table and Pivot Chart Wizard as a guide to locate and

specify tge source data that you want to analyze and to create the report framework. You can then use
the Pivot  Table tool bar to arrange the data with that framework.

 TYPES OF PIVOT TABLE REPORTS:
A default Pivot Table report looks like the preceding example. You can also display a Pivot Table

report in indented format, to view all the summary figures of the same type in one column. You can
create a Pivot Chart report to view the data graphycally. You can also make a Pivot Table report available
on the Web by using a Pivot Table list on a Web page. When you publish an Excel Pivot Table report to
a Pivot Table list, others can view and interact with the date from withi their Web browsers.

 PIVOT TABLE REPORTS: Elements: A Pivot Table report in indented formate is similar to a traditional
database banded report or formatted report. The data for each row field is indented in a layout similar to
a text outline. By using this format, you can read all of the summarized figures for a data fied down a
single column. It’s useful for long reports or reports that you distribute as printouts.

 ROW FILEDS:- Field from the underlying source data that are assigned a row orientation in Pivot
Table report. In the preceding example, Product and Sold by are row fields. A Pivot Table report that
has more  than one row field has one inner row field the one closest to the data area. Any other row field
are referred to as outer row fielfs. Inner and outer row fields have different attributes. Items in the
outermost field are displayed only once, but items in the rest of the filed are repeated as needed.

ADVANCE
DATA RETREVAL
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 COLUMN FIELD:- A field that’s assigned a column orientation in a Pivot Table report. In the preceding

example, Quarters is a column field with two items, Qtr2 and Qtr3. A Prvot Table report can have multiple key
info. column fields just as it can have row fields. Most indented format Pivot Table report do not have column
fields.

  DATA FIELD:- A field from a source list or database that contains data to be summarized. In the example,
Sum of Sales is a data field that summarized the entries from the Sales field, or column, in the source data. In
the indented-format report example, this field is named Sales instead of Sum of Sales.

A data field usually summarized numeric data, such as statistics or sales figures, but the underlying data can
also be text. By default Microsoft Excel summarizes text data in Pivot  Table reports by using the Count
summary function and summarizes numeric data by using Sum.

 CREATE A PIVOT TABLE REPORT:- When  you create a Pivot Table report, Microsoft Excel automatically
create an associated Pivot Table report, and vice versa. If you have an existing Pivot Table report, ou can use
it to create the Pivot Chart: report which will reflect the view of the table. When you base a Pivot Chart report
on external on-OLAP source data, you might have to retrieve the external data before you create the report.
Open the workbook where you want to create the Pivot Chart report.

If  you are basing the report on an Excel list or database, click a cell in the list or database.
1. On the Data menu, click Pivot Table and Pivot Chart Report.
2. In step 1 in the Pivot Table and Pivot Chart Wizard, follow the instructions, and click Pivot
Chart (with Pivot Table under What kind of report do you want to create?
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3. Follow the instructions in

step 2 of the wizard.
4. In step 3 of the wizard,

specify where you want to put the
associated Pivot Table report. The
Pivot Chart report is automatically
created on a new chart sheet. Then
determine whether you need to click
Layout.

If you clicked Layout in step 3 of the
wizard, after you lay out the Pivot
Chart report in the wizard, click OK
in the Layout dialog boxm and then
click Finish to create the Pivot Chart
report.

If you did not click Layout in step 3 of
the wizard, click Finish, and then lay out the Pivot Chart report on  the chart sheet.

  DELETION OF A PIVOT TABLE REPORT
1. Click the Pivot Table report
2. On the Pivot Table toolbar, click Pivot

Table, point to Select, and then click Entire Table.
3. On the Edit menu, point to Clear, and

then click All.
The above details are sufficient to understand the

complete handling of Pivot table elements with
the complete systems. The shortcut key
combinations for using the pivot table option is
listed below.

 Merge or unmerge cells for outer row and
column items :

You can merge cenn for row and column items
in order to center the items horizontally and vertically, or to unmerge cells in order to left-justify items in the outer row
and column fields at the top of the item group.

1. Click the Pivot Table report.
2. The Option tab, the Pivot Table group, click Options.

The Pivot Table Options dialog box appears.
3. To merge or unmerge cells for outer row and column items, click the Layouts & Format tab,
and then under the Layout section, select or clear the Merge and center cells with labels.

Note : You cannot use the Merge Cells check box under the Alignment tab in a Pivot Table report.
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 CHANGE THE NUMBER FORMAT FOR A FIELD :-

1. In the Pivot Table report, select the field of interest.
On the Options tab in the Active Field group, click Field Settings.

The Filed Settings dialog box displays labels and report filters; the Values filed Settings dialog box displays
values.

Click Number Format at the bottom of the dialog box.
The Format Cells dialog box opens.
In the Category list, click the format category of interest.
Select the options that you prefer, and then click OK

twice.

  Area Charts : Data that
is arranged in columns or
rows on a worksheet
can be plotted in an area
chart. Area charts
emphasize the magnitude
of change over time, and
can be used to draw
attention to the total
value across a trend.

For example, data that
represents profit over time can
be plotted in an area chart to
emphasize the total profit
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INSERING & EDITING A PICTURE FROM A FILE

Follow these steps to add a picture, photo or graphic from an existing file :
1. Click on Insert Tab.

2. From Illustrations Group, Click picture
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3. Now select a picture from the location of the picture (where you have stored the picture) and press enter
or click on insert button.

4. The picture is added on the excel sheet. Click on the picture to activate Format tab as shown below along
with itsribbon showing groups like adjust, Picture style. Arrange and Size. Use any of the groups to make necessary
changes in the picture appearance.
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CLOSE  A  MICROSOFT EXCEL:-
To close the current document file, select Offices button  Close Command on the menu bar. If

the file contains any unsaved changes, you will be prompted to save the file before closing.

EXIT MICROSOFT EXCEL PROGRAM:-

When finished your work in Microsoft Excel and closed all the files, you can quite the Microsoft
Excel program by selecting Office button  Exit Excel command on the menu bar.
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MS POWER
POINT

POWERPOINT -  AN INTRODUCTION

Whenever you appear in front of one or more prople to present your ideas, deliver speech, give
classroom lecture, organize computer conference, etc., you have a presentation. The basic purpose of any
presentation is communication. To communicate effective, you must state your facts in a simple, concise

and interesting m anner. A ny presentation consists of four basic elem ents: You your audience, your message

and your tools.

In this lesson you will learn to create a presentation using Microsoft Power Point which is a complete

presentation software. Even if you are not a multimedia expert, PowerPoint helps you create slides and

present exciting slide shows. PowerPoint provides you helpful suggestions on the layout, design, and formats

of your slides.
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WHAT IS POWERPOINT?
Power Point Is Designed To Help Your Effectively Communicate Information To Others. Whether

You’re Talking About A New Advertising Campaign, The Design Of A Modem Intensive Care Unit, Or The
Details Of A New Health Insurance Plan, You Need To Communicate Your Information In A Clear,  Concise
And Interesting Manner. Power Point Helps You To Both Create And Organize The Materials In Your

Presentation.

  THE PARTS OFA PRESENTATION
You May Use A Variety Of Elements In Each Power Point Presentation, Depending On Your Needs. A Slide
Is A Single Visual Image That Can Contain Text Graphics Charts- Just About Anything You Can Images! A
Power Point Slide May Be Displayed On Paper, As An Overhead Transparency.

On A Computer Screen, Or As An Actual Slide That You Project.

 Audience Handouts Provide Printed Copies Of Your Slides Of Your Slides Along With Supporting

Text.

 Speaker’s Notes Provide Small Images Of Your Slides Along With Your Notes, To Serve As A Speaking

Aid That You Can Refer To While You Deliver The Presentation.

 Outline Pages Provide On Outline Of The Entire Presentation Without Graphics.

 When You Create A Power Point Presentation All Parts Of It Are Stored In A Single Presentation File.
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   STARTING A PRESENTATION
It enhance your presentations with pictures, sound effects, tables and charts. The main feature of Power Point are:
 When You Start Power Point Startup Dialog Box Shown. This Dialog Box Gives You The Choice.
 Select Auto Content Wizard If You Would Like To Start By Working On The Organization And Content

Of Our  Presentation.
 Select Template If You Want To Start By Selecting A Template That Specifies Certain Aspects Of Your

Presentation Such As Colour Schemes And Fonts.
 Select Blank Presentation If You Want To Create, A Presentation From Scratch Using All Of Power

Point Default Setting For Colour Font And So On.
 The multiledia features makes your slides sparkle. You can add clip art, sound effects, music, vedio clips

etc.
 Preparing a presentation is easy in PowerPoint. Once if you have created slides, you can put  them in

order, time your slide show, and present them to your audience.
You can start your PowerPoint program in different ways. One way is using Start button.
1. Click on the Start button.
2. In the menu that appears select All Program Microsoft Office Microsoft Office PowerPoint (Fig.). In few

seconds you will see PowerPoint screen on the monitor (Fig.).

 START  ALL PROGRAM  MS OFFICE  MS  POWERPOINT
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CREATING  A PRESENTATION    
When you start your PowerPoint Proram, you see a Blank presentation.

Ribbon consist of a number of Tabs (Home, Insert,......). Tabs are designed to be task oriented.

Groups within each Tab break a task into subtasks.
Commands button in each group carry out a command or display a mwnu of commands.
You can also go to Office button on the top left corner of the page and click on New. You can choose
a black presentation from the page displayed.

Note: In PowerPoint Office button replaces the File menu of other programs and bar below the title

bar is known as the Ribbon (Menu and Tool bars of some other program).
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SLIDE SORTER VIEW
Slide Sorter View Shows You Several Slides On Screen At Once In Miniature You Use Slide Sorter View

To Change The Order Of Slides Add Transition And Set Timings For On Screen Presentations.

To Switch To Slide Sorter View Click The Slide Sorter View Button Or Select View  Slide Sorter.

 SLIDE SHOW:- Slide Show Displays Your Slides One At A Time Full Screen As An On Screen

Presentation. You Use Slide

Show To View The Effects

Of The Transitions And

Timing That You Set In Slide

Sorter View, And To

Present The Presentation

Electronically To An Audi-

ence.

o To Switch To Slide Show

Click The Side Show Button Or

Select View  Slide Show To

Cancel Slide Show Press ESC.
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SAVE A PRESENTATION:-

As You Work It’s A Good Idea To Save Presentation Regularly So You Want Lose Much Work In The
Event Of A Power Outage Or Other Problem. You Must Save The Presentation Before Exiting Power Point Click

The Save Button On The
Standard Toolbar Or Select File
 Save.

OPENING A PRESEN-
TATION:- To Open A
Presentation That Was
Previously Saved To
Disk Click The Open
Button On The Standard
Toolbar Or Select

File  Open.
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UNDO COMMAND:-
As With Word And Excel Power
Point Has An Undo Command That
Reveres You Most Recent Action.

CREATING A NEW SLIDE:-
Click The New Slide Button On The Status Bar Press CTRL+M Or Select Insert  New Slide.

Power Point Displays The New Slide Dialog Box Shown.
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DESIGN A TEMPLATE:-

Click on the Installed Themes box to select the Design Template you want to use. A number of template

names will appear in the white box. These Installed Themes give you different backgrounds and text formatting to

begin your presentation. Preview each design by highlighting the template name on the list. Press Create after you

have chosen the design.
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SLIDE LAYOUTS:-

Once you have chosen a blank form for your new presentation, the first slide of your presentation
appears. You can right click on the site to choose the layout you want. There are nine different slide layouts
from which to choose. You simply make your selection and click on its. Each choice described below,
dictates how your completed slides will appear.
 Title Slide : This option is useful for beginning a presentation; use this slide if you want to

include subtitles or smallerunderneath a title.
 Title and Content: Anytime you need to make to list of things that fall underneath a general

subject, choose this layout.
 Section Header: This is a useful option for putting different elements or text boxes.
 Two Content: This is useful option for putting different elements or text boxes.
 Comparison : This is a useful option for doing pro/con lists.
 Title Only: This option is great for the beginning of a presentation. No subtitles are in

cluded in this layout.
 Blank: Use this layout if you want a blank slide formatted according to the master Slide.
 Content with caption:
 Picture with caption: Use this option to place title over one linked object.
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 SELECTING THE CONTENT:-

There are six types of elements shown inside the text box you can select from the contents within
the slide.
 Insert table
 Insert chart
 Insert Smart Art Graphic
 Insert picture from file
 Insert Clip Art
 Insert Media Clip

 OPEN AN EXISTING PRESENTATION:-
Select the Open tab from the Office button to open an existing presentation. Select the folder the

file is located in from the Look in: drop-down menu and highlight the file on the list. Click Open to open the
presentation.
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VIEW SLIDES
PowerPoint consists of multiple views to help  you in the creation and presentation of your slides. These

views are Normal, Slide Sorter, and Slide Show. The first two views are for  creating your presentation and the last

one is for presentationof slide show. You can access these views by clicking the respective view buttons at the
bottom right of the PowerPoint window. Or select the Vew and then the respective command on the menu bar.
For example, if you want to choose Normal view, select View Normal command on the menu bar.
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NORMAL VIEW:-

The Normal View devides the screen into three sections: the main window, where the current slide is

displayed; the outline pane on the left; and the notes pance at the bottom. This is where you will do most of your

work. You can resize each pane by clicking its border and dragging it to the size that you want it to be. To access

Normal view, click on Normal view button at the bottom left of the window or select View Normal command

on the menu bar.

SLIDE SORTER:-

A small image of each slide is displayed on Slide Sorter View. A Slides can easily be ordered and sorted

using this view. You can also use this view to add special effect, such as the transactions that occur when each new

slide appears. To access Slide Sorter view, click on Slide Sorter view button at the bottom left of the window or

select View  Slide Sorter command on the menu bar.

Slide Sorter View Shows You Several Slides On Screen At Once In Miniature You Use Slide Sorter View

To Change The Order Of Slides Add Transition And Set Timings For On Screen Presentations.

Previous
Slide

Next Slide

Normal
Slide sorter

Slide show
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To Switch To Slide Sorter View Click The Slide Sorter View Button Or Select View  Slide Sorter.

DESIGN TIPS:-

Although, PowerPoint provides you with some very powerful tools to give excellent presentations, making
the wrong design choices can defeat all youe efforts. Making the right decisions is not difficult. By following the
guidelines below, you can prepare best slides.

1. Use contrasting colours for the text and the background so the text will be easy to read.
2. Use font size large enough to be seen from the back of the roomwhere the presentation will

be held. A font size of 24-point or largeris recommended.
3. Use short phrases and sentences to convey your message.
4. Use simple slide transitions. Too many different transitionsswill distract your audience from

the subject of the presentation.
5. Avoid cluttering the slides with too much text or graphics. Your audience should hear what

you have to say and not be distracted by a busy screen.
6. Keep text simple and easy to read by not using many different text effects such as bold

italic, underlining, larger font size for emphasis within a sentence,or a difrferent font all on the same slide.
WORKING WITH SLIDES

Slide are the building blocks of your presentation. You can also create or use layouts and
designs, add notes and create handouts, and customize the look of your slides. You can create new slides by
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inserting them into your show. When you create new slide, you canuse any of the nine layouts available in the New
Slide dialog box or choose a blank slide. Once you have created a new slide, you can insert various elements such
as text, pictures, graphs, tables etc.

APPLYING A DESIGN TEMPLATE
To add a design template or change the existing one, select Design tag on the Ribbon. Select

the template by clicking on it.

CHANGING SLIDE LAYOUTS
To change the layout template of the slide select Home  Layout  command on the menu bar. The

Slide Layout dialog box appears with nine layouts. Click on one of the layout thumbnail images to apply.
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 DUPLICATE SELECTED SLIDES:-

Duplicate Selected

Slides gives you a duplicate

of a slide when you need

to create similar slides. To

insert a copy of the cur-

rent slid after the current

slide, choose the slide you

want to duplicate, and

then Right Click for the

Duplicate Slide Com-

mand on the menu bar or

press CTRL+SHIFT

+D Keys. You can also

cut/and paste slide by se-

lecting the whole slide.

HIDE SLIDES:-
If you do not want a

slide to appear during the

slide show, but do not

want to delete the slide as

it may be used later, the

slide can be hidden by

right clicking on the slide

in the slide pane and se-

lecting Hide .  You can

unhide a hidden slide in a

similar manner.
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MOVING BETWEEN SLIDES:-

You can move from one slide to another slide by using the following tools.

Scrool Bars:- Use the Scroll Bars to move from one slide to another slide or through the text that is

displayed in the notes pane and the outline pane.

Next Slide and Previous Slide Buttons:- The Next Slide and Previous Slide buttons move you to the

next slide or previous slide in a slide show. These buttons, indicated by a double-arrow, are located at the bottom

of the vertical scroll bar.

Using Outline Pane:- Change to Outline view and then click on the slide that you want to view. You

can move around in the outline pance by using your mouse, or by using up and down arrow keys.

Previous
Slide

Next Slide
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 WORKING WITH TEXT

You can work with text to communicate your ideas t your audience. PowerPoint gives you several ways to

insert, edit and format text for you presentations.
 Inserting Text

You can insert by using the outlining or nserting text boxes.

 Outline Text : The outline text can be used to create slides of a similar nature. By using the Outlines
toolbar, you can create heads, lists and paragraphs. PowerPoint uses the format of your outline to cor-
rectly insert text in a slide. Heading I becomes the title of a slide, heading 2 becomes the first line of the text

box, and so on. When you select a predefined layout and switch over to Outline view as explained earlier,
you can see the Outline text options on the left side window. To choose Outlining toolbar, select the Outline
pane next to the slide pane on left side below the menu bar.

Text Box :  The text boxes are the wat that PowerPoint puts text on a slide. When you create a slide, and use
a specific slide layout, the slide will have one or more text boxes in it. Simply click on the existing text to
add new text.
If you want to add a new text box to the slide, select Insert  Text Box command on the menu bar and
then draw the text box wth the mouse at a place where you want to insert the text box.
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If  you want to resize a text box, follow the steps given below:

 Select the text  box you wish to resize by clicking on it with the mouse. A border with eight
handles will appear around the text box. The four  handles on the corners will resize the
length and width of the box at once while the handles on the sides will resize only in one
direction.

 Click one of the handles are per your requirement and drag it with the mouse. Release the
mouse button when it is the size you want to be. Move the text box by clicking and draggin
the thick dotted border with the mouse.

FORMATTING TEXT:-
Format Fonts :- Select the text that will be formatted by highlighting the text either on the outline
or on the slide. You can select from Home Font menu bar or right click on the highlighted selection and
select the Font menu from the popup shortcut menu. Select a font size, style, effect and colour from the
Font dialog box.

Line Spacing :- Change the amount of space between lines in a text box by selecting Home Line Spacing from the
Paragraph menu bar.

 Line Spacing - Select the amount of vertical space between lines. A value of “l” is equal to single

spacing and “2” is double spacing. Value between and above these numbers are valid as well.

Replace Font:- Design templates have a preset font that you may want to change or you want to change the font

used on for the entire presentation for a number of reasons. This can be accomplished quickly using the

Replace Fonts feature. Select Home  Replace  Replace Fonts from the menu bar. Choose the
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font you want to Replace from the first drop-down menu and the font it should e replaced with from the

second menu, and click the Replace button.

BULLETS LISTS ON DESIGN TEMPLATES:- Bulleted lists allow you to clearly display

the main points of your presentation on slides. The text boxes on design templates alreadt include bulleted

lists. Click the placeholder on the slide to begin adding text and press the ENTER key to return to the next

line and add  a ew bulleted item. To go to the next line without adding another bullet, hold down the SHIFT

key while pressing ENTER.

1. In slide view, create a text box by select-

ing Insert  Text Box from the menu bar.

2. “Draw” the text box on the slide by hold-

ing down the left mouse button hile you move

the mouse until the box is the size you want

it.

3. Choose the Bullets or Numbering from

the Home  Paragraph menu bar.

4. Change the size of the bullet by changing

the percentae in relation to the text.

5. Choose a colour for the bullet from the

Colour menu Click More Colours for a

larger selection.

6. Select one of the bullet  types shown and

click OK. Or click the Picture button to

view the Picture Bullet win-

dow. Select one of the bul-

lets and click OK. Or lick

the character button to se-

lect any character from the

fonts on the computer. Se-

lect a symbol font such as

Wingdings or Webdings

from the Bullets from

drop-own menu for the best

selection of icons. Click on

the characters in the grid to

see them larger. Click OK.

when you have chosen the

bullet you want to use.
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BULLETED LIST AND NEW SLIDES FROM AN OUTLINE :- In Normal or Outline

view, text can easily be entered in the outline window and new slides are automatically added. Follow the

steps below to become familiar with adding slide content in Outline view:

 Next to the Slide 1 icons, type the title of the slide. The text you type beside the slide icons with be the

large-type titles on each slide.

 Press ENTER key to type the next line. This will automatically create a new slide. To create a bulleted list

for the first slide, press the TAB key or ALT+SHIFT+RIGHT Arrow keys to demote the selection toa

bulleted list item.

 Continue entering text for the bulleted list, pressing ENTER key at the end of each line to create a new

bullet.

 Create a multilevel list by executing the above action again to create a bulleted sublist. Press

ALT+SHIFT+Left Arrow keys to return to the original list.

 Continue creating new slides and bulleted lists by using the above actions until the presentation  is com-

pleted. Use the formatting instructions below to format the lists.

If there is more than one bulleted list on the slide, the lists will be designated by numbers enclosed in black

boxes. The example below shows the slide created from the outline on the left. The bulleted list on the left slide of
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the slide is labeled list “1” on the outline and the list on the right is labeled list “2”. When typing the outline, begin

typing in the new list by pressing CTRL+ENTER keys.

Numbered List :  Follow these step to create a numbered list :

 Create  a text box.

 With the text box selected, choose Home Paragraph  Numbering from the menu bar.

 Click the Numbered tab at the top of the Bullets and Numbering window.

 Change the size of the numbers by changing the persentage in relation to the text.

 Choose a colour for the numbers from the Colour menu. Click More Colours for a larger selection.

 Change the Start at value if the numbers should not begin with 1.

 Select one of the sevel list types shown and click OK.

CHANGE CASE :- Change the case of the characters in a paragaph by selecting Home Change

Case from the Font menu bar without having to retype the text.
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 Sentence case - Capitalizes the first letter of the first word in each sentence.

 Lowercase and Uppercase - Changes the case of all the letters.

 Title case - Capitalizes the first letter of every word and reduces the rest to lowercase.

 Toggle case - The opposite of Title case, it makes the first letter of every word lowercase and

capitalizes the remaining letter.

SAVING AND PRINTING
You can save your presen-

tation slide as a file in a folder. You

can also save the slides as Web

page so that you can post them on

Internet. Printing is similar to what

you have done in Word and Excel.

Remember to set up your page be-

fore saving or printing your presen-

tation slides.
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PAGE SETUP:- Select Office button   Print Preview from the menu bar to access options for

printing the presentation slides. Select the format the printed slides will be used for from the slides drop-

down menu.

PRINT - Select Office button  Print command on the menu bar to print the presentation. The Print dialog box

appears. Choose the following options in the Print box.

Print  Range - Select All to print all the slides in the presentation, Current slide to print only the current

slide, or enter slide numbers in the Slides field to print only certain slides.

COPIES - Enter the number of copies of each slide specified in Print range and check the Collate box if necessary.
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PRINT WHAT :-

 Slides - Prints a full-page slide on each page.

 Handouts - Prints as many slides as you designate on each page.

 Notes Page - Prints one slide with that slide’s notes on each page.

 Outline view - Prints the outline of the presentation Click OK to PRINT.
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CLOSE A DOCUMENT
To close the current presentation slides file, select Offices button  Close Command on the menu

bar. If the file contains any unsaved changes, you will be prompted to save the file before closing.

EXIT POWERPOINT PROGRAM
When finished your work in PowerPoint and closed all the files, you can quite the PowerPoint

program by selecting Office button  Exit PowerPoint command on the menu bar.
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ACTION KEY STROKE
Ope a presentation CTRL + O
New presentation CTRL + N
Save  As F12
Save CTRL + S
Print CTRL + P
Help F1

  PRESENTATION ACTIONS
Begin slide show F5
Next Slide ENTER or Down arrow key
Previous slide BACKSPACE or Up arrow key
Activate pen tool CTRL + P
Erase pen strokes E
Dectivate pen tool CTRL + A
Show/Hide black screen B
Show/Hide white screen W
Show/Hide pointer & button A
End slide show ESC

  FORMATTING
Select all CTRL + A
Cut CTRL + X
Copy CTRL + C
Paste CTRL + V
Undo CTRL + Z
Redo CTRL + Y
Bold CTRL + B
Italic CTRL + I
Underlines CTRL + U
Left justified CTRL + L
Center justified CTRL + E
Right justified CTRL + R
Promote list item ALT+SHIFT+ Left Arrow
Demote list item ALTSHIFT + Right Arrow or TAB

  EDITING
Find CTRL + F
Replace CTRL + H
Insert hyperlink CTRL + K
New Slide CTRL + M
Spell checker F7
Macros ALT + F8

KEYBOARD SHORTCUTS:-Keyboard shortcuts can save time and the effort of switching from
the keyboard to the mouse to execute simple commands. Print this list of PowerPoint keyboard shortcuts and keep
it by your computer for a quick reference.
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MSACCESS
CCESS -  AN INTRODUCTION

MS-ACCESS
Microsoft Access Is Powerful Database Software. It Allows You To Create, Manage

And Process Data In The Form Of A Table. Each Specific Piece Of Information In A Table In
Know As Valve. A Valve Is Located At The Intersection Of Raw And Column.

DATA BASE:-

Data Base Is A Collection Of Data Which Is Organized In A Manner That Can Be
Easily Retrieved. They Consist Of Fields, Records And Files.

The Soft Ware That Is Used To Access, Retrieve, Modify, Delete, Search Sort Design
And Print Data Is Called Data Base Management System (DBMS).

“The Database Software Package With Ms-Office Helps Us To ‘Create’ ‘Maintain’ ‘Update’
And ‘Present’ Data Base In Ms Access Through A Graphical User Interface (GUI)”.

A Data Base Is An Organized Way Of Storing Large Amount Of Related Data.

  START   ALL PROGRAM  MS OFFICE   MS  ACESS
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